


            คูมือการใชงานบอรด CP-JR LPT v1.0        

 
คํานํา 

Preface 
 

พอรตเครื่องพิมพ ( Parallel Port ) หรือ หลายคนอาจรูจักในชื่อของพอรตปร้ินทเตอร ซึ่ง
ปจจุบัน พอรตนี้ไมไดใชสําหรับตอเครื่องพิมพเพียงอยางเดียว แตมันสามารถนํามาประยุคใช
สําหรับการควบคุมอุปกรณไฟฟา หรือ สิ่งตางๆ ไดอีกดวย โดยการเขียนโปรแกรมเพื่อสั่งงานขา
ตางๆ ของพอรตเครื่องพิมพ ซึ่งในเนื้อหาของคูมือนี้จะอางอิงการเขียนโปรแกรมดวย Visual 
Basic 6.0 เทานั้น 

 

เนื้อหาในหนังสือคูมือนี้จะอางอิงกับบอรด 2 รุน คือ CP-JR LPT V1.0 และ ET-BASE 
LPT V1.0 ซึ่งบอรดทั้ง 2 รุนนี้จะมีวงจร และ การทํางานที่เหมือนกัน คือ เปนบอรดควบคุมไอซี 
8255 ดวยพอรตเครื่องพิมพ ,เพียงแตบอรดรุน ET-BASE LPT จะมีจั้มเปอรเลือกแหลงจายไฟ 5 
VDC จากภายใน หรือ ภายนอกไดดวย  

 

 สุดทายนี้ผูเขียน และ ทีมงาน ETT หวังเปนอยางยิ่งวาหนังสือคูมือ และ บอรดทดลอง 
CP-JR LPT/ET-BASE LPT V1.0 นี้จะชวยใหผูอาน และ ผูสนใจเขาใจการทํางานของพอรต
ขนาน ( Parallel Port ) และ การตอรวมกับไอซี 8255 มากยิ่งขึ้น และ หากผูอานมีขอคิดเห็น 
หรือ มีขอทวงติงเกี่ยวกับเนื้อหาภายในหนังสือคูมือฉบับนี้ สามารถใหขอคิดเห็นผานทาง e-mail 
: sales@etteam.com ซึ่งทางผูเขียน และ ทีมงาน ETT จะขอนอมรับไวเพื่อการปรับปรุงในการ
ตอไป 
 
 
 
                       จักรพันธ จิตรทรัพย 
                        14 กุมภาพันธ 2548 
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                  1 
ทรัพยากรบนบอรด  

CP-JR LPT V1.0 /ET-BASE LPT V1.0 

 
 
  
 บอรด CP-JR LPT v1.0 และ ET-BASE LPT v1.0 เปนบอรดขยายพอรต I/O ดวยไอซี 8255 ซึ่ง
ควบคุมการทํางานผานทางพอรตเครื่องพิมพ ( Parallel Port ) โดยในสวนของการจัดวงจรทาง Hardware 
ของบอรดทั้ง 2 รุนนี้จะอางอิงกับโหมด EPP  ( Enhanced Parallel Port ) ของพอรตเครื่องพิมพ  
 

 บอรด CP-JR LPT v1.0 และ ET-BASE LPT v1.0 ทั้ง 2 รุนนี้จะนําทานผูอานสูการควบคุมอุปกรณ
อิเล็กทรอนิกส หรือ อุปกรณไฟฟา ผานทางพอรตเครื่องพิมพ ( Printer port ) ของคอมพิวเตอร  ซึ่งจากเดิม
หลายคนเคยผานการควบคุมดวยไมโครคอนโทรลเลอรมาบางแลว เชน MCS-51, PICหรือ Z-80. การควบ
คุม หรือ ส่ังงาน I/O Port ผานทางคอมพิวเตอรจะมีขอดีตรงที่หนาตางโปรแกรมมีความสวยงาน ผูใช
สามารถมองเห็น และ เขาใจการทํางานของโปรแกรมไดโดยงาย 
 

 บอรด 2 รุนนี้จะมี วงจร และ การทํางานหลักๆ ที่เหมือนกัน แตบอรดรุน ET-BASE LPT V1.0 จะมี
จั้มเปอรสําหรับเลือกแหลงจายไฟ 5 VDC จากภายนอกไดดวย เนื่องจากวาบอรดรุน ET-BASE LPT V1.0 
ถูกออกแบบมาใหสามารถตอใชงานรวมกับชุดฝก ET-BASIC I/O V1.0 ไดดวย ดังนั้น ผูอานสามารถดึงแรง
ดันไฟ 5 VDC จากบอรด ET-BASIC I/O V1.0 มาใชได 
 

 การพัฒนาโปรแกรมในหนังสือคูมือนี้จะอางอิงกับการเขียนโปรแกรมดวย Microsoft Visual Basic 
6.0 ซึ่งผูอานจะตองทําการติดตั้งโปรแกรมไวบนเครื่อง PC เปนที่เรียบรอยแลว  
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รูปแสดงลักษณะโครงสรางบอรด CP-JR LPT v1.0 

 

 
 

รูปแสดงลักษณะโครงสรางบอรด ET-BASE LPT v1.0 
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ทรัพยากรบนบอรด CP-JR LPT v1.0/ ET-BASE LPT v1.0 
 

 ทรัพยากรบนบอรด CP-JR LPT v1.0 นั้นหลักๆ ไดแก ข้ัวพอรต DB25 ซึ่งใชสําหรับตอระหวาง
เครื่องคอมพิวเตอร กับ บอรด CP-JR LPT v1.0 , ข้ัว 34 Pin 72IOZ80 ใชเปนเอาทพุตสําหรับตอกับโหลด 
ซึ่งพอรต PA, PB, PC ของไอซี 8255 จะถูกตอออกมาที่ข้ัว 34 Pin นี้ , จั้มเปอร EXT/INT จะมีเฉพาะบอรด
รุน ET-BASE LPT V1.0 เทานั้น ซึ่งใชเลือกแหลงจายไฟ 5 VDC  
 
จั้มเปอร EXT/INT ( สําหรับบอรด ET-BASE LPT V1.0 เทานั้น ) 
 

 จั้มเปอร EXT/INT ใชสําหรับเลือกแหลงจายไฟ 5VDC จากภายนอก หรือ แหลงจายไฟจากภายใน
ซึ่งจะรับไฟ 9 – 12 VAC/DC แลวแปลงเปน 5VDC 
 

 
 

รูปแสดงจั้มเปอร EXT/INT 

 
พอรตขนาน ( Parallel Port )  

 

 พอรตขนาน หรือ พอรตเครื่องพิมพมีขาทั้งหมด 25 ขา ( D- type ) ซึ่งผูอานจะตองตอสายจาก
เครื่องคอมพิวเตอร PC มาที่ข้ัวตอนี้ ซึ่งการดูตําแหนงขาแสดงดังภาพดานลาง  
 

 

   
 

 

 

 
 

รูปแสดงการดูขาของพอรตขนาน ( Parallel Port )  
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ตารางแสดงชื่อขาของพอรตขนาน ( Parallel Port ) ในโหมดการทํางานตางๆ  
Standard Parallel Port (SPP) Enhanced Parallel Port 

(EPP) 
Extended Capabilities Port 

(ECP) 

Signal Name Centronics 
(36-pin) 

DB-25 
(25-
pin) 

Signal Name DB-25 
(25-pin) Signal Name DB-25 

(25-pin) 

Strobe 1 1 Write 1 Host CLK 1 
Data 0 2 2 Data 0 2 Data 0 2 
Data 1 3 3 Data 1 3 Data 1 3 
Data 2 4 4 Data 2 4 Data 2 4 
Data 3 5 5 Data 3 5 Data 3 5 
Data 4 6 6 Data 4 6 Data 4 6 
Data 5 7 7 Data 5 7 Data 5 7 
Data 6 8 8 Data 6 8 Data 6 8 
Data 7 9 9 Data 7 9 Data 7 9 

Acknowledge 10 10 Interrupt 10 Periph CLK 10 
Busy 11 11 Wait 11 Periph ACK 11 

Paper End 12 12 Spare 12 Ack Reverse 12 
Select 13 13 Spare 13 X-Flag 13 

Auto Line Feed 14 14 Data Strobe 14 Host ACK 14 
Error 32 15 Spare 15 Periph Request 15 

Initialize Printer 31 16 Reset 16 Reverse Request 16 
Select Input 36 17 Address Strobe 17 1284 Active 17 

Strobe Return 19 18 Ground 18 Ground 18 
Data 0 Return 20 19 Ground 19 Ground 19 
Data 1 Return 21 19 Ground 20 Ground 20 
Data 2 Return 22 20 Ground 21 Ground 21 
Data 3 Return 23 20 Ground 22 Ground 22 
Data 4 Return 24 21 Ground 23 Ground 23 
Data 5 Return 25 21 Ground 24 Ground 24 
Data 6 Return 26 22 Ground 25 Ground 25 

Data 7 Return 27 22     

Acknowledge Return 28 24     

Busy Return 29 23     

Paper End Return 28 24     

Select Return 28 24     
Auto Line Feed 

Return 30 25     

Error Return 29 23     
Initialize Printer 

Return 30 25     

Select Input Return 30 25     

Shield 33 N/C     

N/C 34 N/C     

N/C 35 N/C 
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พอรต 72IOZ80 

 

 พอรต 72IOZ80 เปนพอรตขนาด 34 Pin ซึ่งแตละขาจะเปนขาเอาทพุตของ IC 8255 ซึ่งไดแก PA, 
PB, PC รวมถึงแหลงจายไฟ +5 V และ GND ดวย ดังแสดงในภาพดานลาง 
 
 

34
32
30
28
26
24
22
20
18
16
14
12
10
8
6
4
2

33
31
29
27
25
23
21
19
17
15
13
11
9
7
5
3
1

 

PA2
PA4
PA6
PB0
PB2
PB4
PB6
PC0
PC2
PC4

PA1
PA3
PA5
PA7
PB1
PB3
PB5
PB7
PC1
PC3
PC5
PC7

VCC

PA0

PC6

 

รูปแสดงชื่อขาตางๆ บนพอรต 72IOZ80 
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                  2 
ทฤษฎีพอรตขนาน 

 
 
  
 
 ส่ิงแรกกอนที่จะศึกษาพอรตขนาน ( Parallel Port )  คือ การเรียนรูวิธีที่จะใชประโยชนสูงสุดจาก
มันไดอยางไร, รวมถึงวิธีการติดตั้งพอรต และ วิธีการเลือกโหมดการใชงานตางๆ ซึ่งเนื้อหาในบทที่ 2 นี้จะ
กลาวถึงสิ่งจําเปนตางๆ สําหรับการใชงานพอรตขนาน ( Parallel Port ) 
 
คําจํากัดความของพอรต 
 

 พอรตขนาน ( Parallel Port ) คือ อะไร ? ในโลกของคอมพิวเตอร, พอรตๆ หนึ่งจะประกอบไปดวย
กลุมของสายสัญญาณหลายๆ เสนมารวมกัน ซึ่งพอรตตางๆ เหลานี้จะใชในการแลกเปลี่ยนขอมูลระหวาง
พอรต (PC) กับ อุปกรณตางๆ ที่ตออยูดวยกัน 
 

 พอรตขนาน ( Parallel Port ) คือ พอรตที่มีการสงถายขอมูลหลายๆ บิตในเวลาเดียวกัน ในขณะที่
พอรตอนุกรม ( Serial Port ) จะมีการสงถายขอมูลทีละ 1 บิต ซึ่งจะสงผลใหการสงถายขอมูลของพอรต
ขนานนั้นมีความรวดเร็วกวาพอรตอนุกรมแตการใชงานพอรตขนานจะตองใชจํานวนสายสัญญาณมากกวา 
 

 เนื้อหาภายในบทนี้จะสามารถใชงานไดกับคอมพิวเตอร PC หรือ คอมพิวเตอรสวนบุคคลโดยทั่วๆ
ไป ซึ่งอางอิงกับมาตรฐานของ IBM PC เนื่องจากคอมพิวเตอรสวนบุคคลสวนใหญจะพัฒนามาจากมาตร
ฐาน IBM อยูแลว  
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พอรตขนาน( Parallel Port ) ของคอมพิวเตอรในยุคแรกๆ จะมี 8 บิตที่ทําหนาที่เปนเอาทพุต, มี 5 
บิตทําหนาที่เปนอินพุต และ มี 4 บิตที่สามารถเปนไดทั้งอินพุต/เอาทพุต ( Bidirectional lines ) แตปจจุบัน
คอมพิวเตอรสวนบุคคล ( PCs ) นั้นสามารถใชงานเอาทพุต 8 บิตใหเปนอินพุต 8บิต ไดอีกดวย ซึ่งทําให
อุปกรณที่ตอรอบนอกคอมพิวเตอร ( Peripherals Devices ) เชน Scanners, drives และ อุปกรณอ่ืนๆ 
สามารถสงขอมูลกลับมาใหกับคอมพิวเตอร PC ไดดวย และ ทําใหการสงถายขอมูลนั้นมีความรวดเร็วขึ้น 
 

 กอนหนานั้น, พอรตขนาน ( Parallel Port ) ถูกออกแบบใหเปน Printer Port หรือ พอรตเครื่องพิมพ
เพียงอยางเดียว ซึ่งผูอานจะเห็นไดจากชื่อของสายสัญญาณตางๆ ที่อยูบนพอรตซึ่งจะสื่อถึงการใชงานได
อยางทันที เชน PaperEnd, AutoLineFeed เปนตน แตทุกวันนี้, ผูอานจะสามารถพบอุปกรณตางๆ ที่นอก
เหนือไปจาก Printers ตออยูที่พอรตขนาน หรือ พอรตเครื่องพิมพนี ้
 

 
รูปแสดง รีจิสเตอรตางๆ ที่อยูบนพอรตขนาน 

 

พอรตขนานชนิดตางๆ 
 

 การออกแบบเครื่องคอมพิวเตอร PC ไดมีวิวัฒนาการขึ้น โดยผูผลิตคอมพิวเตอรหลายบริษัทไดเร่ิม
มีการปรับปรุงเวอรชั่นของพอรตขนาน ( Parallel Port ) ซึ่งพอรตชนิดใหมนี้สามารถใชงานไดกับพอรต
ขนานชนิดเกา ( Original design ) ทุกประการ แตพอรตขนานที่ออกแบบใหมนี้จะมีความสามารถเพิ่มข้ึน
โดยจะเนนในเรื่องความเร็วในการสงถายขอมูลเปนหลัก และ ในเนื้อหาบทนี้จะครอบคลุมพอรตขนานเวอร
ชั่นใหมนี้ดวย และ ทางดานลางจะเปนการสรุปโหมดชนิดตางๆ ของพอรตขนาน  
 

 Original (SPP) คือ พอรตขนานแบบเกาในมาตรฐาน IBM ( Original IBM PC ) และ พอรตขนาน
บางเครื่องที่มีการออกแบบเหมือน Original IBM PC จะถูกเรียกวา  SPP หรือ Standard Parallel Port 
หรือ หลายคนรูจักในนาม TA-type หรือ  ISA-compatible นั้นเอง ซึ่งเปนพื้นฐานในการเชื่อมตอกับ
เครื่องพิมพ แตตอมาไดเร่ิมมีการเพิ่มเติมความสามารถหลายๆ อยางเขามาดวย ดังนั้น ความสามารถ
ของพอรตอาจจะเพิ่มเติมจากหลักการบางเล็กนอย 
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 SPPs สามารถสงถายขอมูล 8 บิตที่เวลาเดียวกันไปที่อุปกรณที่ตออยูกับมันได โดยใช Protocol 
เชนเดียวกับการเชื่อมตอกับเครื่องพิมพ แต SPPไมสามารถรับขอมูล 8 บิตจากอุปกรณรอบนอกเขามา
ได 

 

 SP/2-type ( Simple Bidirectional ) คือ การปรับปรุงอยางแรกของพอรตขนาน ( Parallel Port ) 
โดยการทําใหมันเปน Bidirectional data port ซึ่งบริษัท IBM เปนผูผลิตขึ้นโดยมีชื่อวา PS/2 ซึ่งมัน
สามารถรับขอมูล 8 บิตจากอุปกรณรอบนอกเขามายัง PC ได ซึ่งขอกําหนดของ PS/2-type ที่มีมานั้น
จะอางอิงกับพอรตขนาน ( Parallel Port ) ใดๆ ที่มี Bidirectional data port แตจะไมสนับสนุนการ
ทํางานในโหมด EPP หรือ ECP ซึ่งจะไดอธิบายในหัวขอตอไป 
 

 EPP ( Enhanced parallel port ) EPP ถูกพัฒนาโดยบริษัท Intel ซึ่งเปนผูผลิตชิปคอมพิวเตอร
รายหนึ่ง, บนพอรตแบบ PS/2 บิตขอมูลตางๆ สามารถสื่อสารแบบ Bidirectional ไดซึ่ง EPP ก็สามารถ
อาน หรือ เขียนขอมูล 8 บิตไดเชนกัน แตการทํางานในโหมด EPP นั้นจะมีความรวดเร็วกวา ซึ่งใชเวลา
ในการอาน หรือ เขียนเพียง 1 cycle เทานั้น หรือ ประมาณ 1us ( บนบัส ISA ) ในขณะที่พอรต SPP 
หรือ PS/2-type จะตองใชถึง 4 cycle. การทํางานในโหมด EPP สามารถเปลี่ยนทิศทางการสงขอมูลได
อยางรวดเร็วมาก ดังนั้น พอรต EPP จึงถือวาเปนพอรตที่มีประสิทธิภาพอยางมากในการตอใชงานกับ 
Disk, Tape drives และ อุปกรณอ่ืนๆ นอกจากนั้นพอรต EPP ยังสามารถเลียนแบบการทํางานของ 
SPP หรือ SP/2-type ไดอีกดวย 
 

 ECP ( Extended Capabilities Port ) พอรต ECP ถูกเสนอขึ้นมาโดยบริษัท Hewlett Packard  
และ Microsoft ซึ่งมีการทํางานเหมือนกับ EPP แต ECP จะมี Buffer อยูภายใน และ สามารถรองรับ
การสงถายขอมูลแบบ DMA ( Direct memory access ) และ สามารถบีบอัดขอมูลได การสงถายขอ
มูลแบบ ECP นั้นมีประโยชนกับ เครื่องพิมพ ( Printers ) , Scanners, และ อุปกรณรอบนอกตางๆ ที่
ตองการการสงถายขอมูลขนาดใหญ นอกจากนั้นพอรต ECP สามารถเลียนแบบการทํางานแบบ SPP 
หรือ PS/2-type หรือ EPP ไดอีกเชนกัน 

 

 
 

 ETT CO.,LTD.                                       8                                     WWW.ETT.CO.TH  



            คูมือการใชงานบอรด CP-JR LPT v1.0        

 ETT CO.,LTD.                                       9                                     WWW.ETT.CO.TH  

 

ตําแหนงแอดเดรสของพอรตขนาน 
 

 โดยปกติมาตรฐานของพอรตขนานจะมี Base address ที่ใชกันบอยๆ อยู 2 คา คือ LPT1 = 378H 
และ LPT2 = 278H ซึ่งผูอานสามารถเปลี่ยนแปลงคา Base address ไดที่ BIOS 
 

ตาราง แสดงตําแหนงแอดเดรสของพอรตขนาน 
LPT1 LPT 2                  ช่ือพอรต 

 

ช่ือรีจิสเตอร ฐาน16 ฐาน16 
Data Register 378H 278H 
Status Register 379H 279H 
Control Register 37AH 27AH 

 
 ในการตรวจสอบเครื่องคอมพิวเตอรของผูอานวาถูกกําหนดอยูพอรตไหน หรือ โหมดอะไร สามารถ
ทําไดโดยคลิ๊กขวาที่ไอคอน My Computer =>Properties => Hardware => Device Manager จะไดภาพ
ที่แสดงดานลาง 
 

 
 

รูปแสดง การตรวจสอบพอรตขนานของเครื่องคอมพิวเตอร 
 
 
 

ดับเบิลคล๊ิก
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 จากรูปทางดานบนผูอานจะพอทราบแลววาคอมพิวเตอรถูกกําหนดอยูตําแหนงใด โดยจากรูปจะ
เปนการใชงานโหมด ECP และ ใชพอรต LPT1 ซึ่งหมายความวาการเขาถึงรีจิสเตอรของพอรตขนานจะเปน
ดังนี้ คือ 
 

  Data Register : อยูที่ตําแหนงแอดเดรส 378H 
  Status Register : อยูที่ตําแหนงแอดเดรส 379H 
  Control Register : อยูที่ตําแหนงแอดเดรส 37AH 

 
 ถาทานผูอานยังไมทราบขอมูลเหลานี้ใหดับเบิลคลิ๊กตามรูปดานลาง ที่หัวขอ General ผูอานจะ
เห็นรายละเอียดทั้งหมด นอกจากนั้นในหัวขอ Resources สามารถตรวจสอบตําแหนงแอดเดรสไดอีกดวย 

 

 
 

รูปแสดง การตรวจสอบพอรตขนานของเครื่องคอมพิวเตอร 
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ขาสัญญาณบนพอรตขนาน 
 

 ตารางดานลางแสดงการกําหนดชื่อขาของพอรตขนาน ( DB 25 ) ในโหมด EPP ซึ่งจากตารางผู
อานจะเห็นวาชื่อขา และ การใชงานในแตละขาของโหมด SPP กับ EPP จะไมเหมือนกัน ดังนั้น ถาผูอาน
ตองการทราบรายละเอียดในโหมด SPP หรือ ECP ผูอานสามารถอานไดจากไฟลเอกสารใน CD-ROM ที่
แถมไปกับผลิตภัณฑ 
 

ตาราง แสดงชื่อขาของพอรตขนาน ( D-Type 2 Pin ) ในโหมด EPP 

 
 

 

 

 ETT CO.,LTD.          
Data Register 
Status Register 
รูป แสดงกลุมของขาสัญญาณ และ บิตที่มีการกลับสัญญาณ 
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The Data Register 
 

 Data Port  หรือ Data Register, ( D0 – D7 ) ในโหมดการทํางานแบบ SPP นั้นรีจิสเตอรนี้จะทํา
หนาที่เปนเอาทพุตไดอยางเดียว แตสําหรับโหมด EPP และ ECP จะสามารถกําหนดเปนอินพุตไดโดยผูอาน
จะตองสั่งเขียน Data Register ใหเปน ‘1’ ทุกบิตดวยคา FFH กอนจากนั้นจึงกําหนดบิต C5 ( Direction 
Control ) ซึ่งอยูใน Control Register ใหเปน ‘1’ ( Data outputs Disabled )  
 
The Status Register 
 

 Status Port, หรือ Status Register , รีจีสเตอรนี้มี 5 บิตที่ทําหนาที่เปนอินพุต คือ S3 ถึง 7S  โดย
บิต S0 – S2 จะไมปรากฎที่ขาของพอรตขนาน และ รีจิสเตอรนี้สามารถอานไดอยางเดียวเทานั้น ซึ่งแตละ
บิตมีหนาที่ดังนี้ คือ 

 

 ในโหมด EPP ถาบิตนี้เปน High จะแสดงถึงการเกิด timeout ของ การสงถายขอ
มูลในโหมด EPP ถาในโหมดอื่นบิตนี้จะไมใชงาน และ บิตนี้จะไมปรากฎที่ขาของพอรตขนาน 

.:0 TimeoutS

  .:1 UnusedS

  .:2 UnusedS
  หรือ บิตนี้จะเปน Low เมื่อเครี่องพิมพตรวจพบ Error หรือ fault ( อยาสับ
สนกับบิต S5 ( PError ) นะ 

.:3 nErrorS .nFault

  บิตนี้จะเปน High เมื่อเครื่องพิมพ On-line ( เมื่อ Input data ของเครื่องพิมพ 
Enabled ) 

.:4 SelectInS

 หรือ บิตนี้จะเปน High เมื่อเครื่องพิมพกระดาษหมด ,,:5 PaperEmptyPaperendS .PError

 หรือ บิตนี้จะเปนสัญญาณ Pulse low เมื่อเครื่องพิมพไดรับขอมูล 1
ไบต ถาไดเปดการใชงาน Interrupt เอาไวจากบิต C4 จะทําใหเกิดการ Interrupt 

.:6 nAckS .genAcknowled

 .:7 BusyS บิตนี้จะเปน Low เมื่อเครื่องพิมพไมสามารถรับขอมูลใหมได และ บิตนี้จะกลับ
สัญญาณที่พอรตขนาน ( Connector ) 
 
The Control Register 

 

 Control Port, หรือ Control Register, มี 4 บิต คือ 0C  จนถึง 3C  ในขณะที่ C4 ถึง C7 จะไมถูก
ตอไปที่ขาของพอรตขนาน ในสวนของบิตที่มีบาร อยูคางบนมีความหมายวาบิตๆ นั้นจะกลับสภาวะกอน
ออกไปที่พอรตขนาน ( Connector )  
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 บิตของ Control Register เหลานี้จะจัดวงจรเปนแบบ Open-collector หรือ Open-Drain type ซึ่ง
หมายความวาพวกมันสามารถทําหนาที่เปนอินพุตไดดวย โดยคุณผูอานจะตองเขียนลอจิก ‘1’ ออกไปที่บิต 
Control ที่ผูอานตองการจะใหเปนอินพุตกอน หลังจากนั้นใหอานขอมูลจากบิต Control Register นั้นๆ ได
เลย ในสวนของหนาที่การทํางานของบิตตางๆ แสดงไดดังนี้ คือ 
 

 .:0 nStrobeC  บิตนี้จะใชในกรณีที่เครื่องพิมพอานคาขอมูล D0 – D7 และ โดยปกติหลังจากบูต
เครื่องที่พอรตขนานจะมีลอกจิก High 
 .:1 AutoLFC หรือ  . ถาบิตนี้เปนลอจิก Low  ซึ่งจะเปนการบอกใหเครื่อง
พิมพทํา Line feed ( ASCII code = 0AH ) 1 คร้ัง หลังจากมีการกดปุม Enter ( Carriage Return = ASCII 
0DH ) 

Automatic line feed

 หรือ  ถาบิตนี้จายสัญญาณพัลสลบ จะทําใหเครื่องพิมพนั้นรีเซ็ต และ 
เคลีย Buffer ซึ่งพัลสที่จายใหกับเครื่องพิมพนั้นอยางนอยตอง 50 ms  

.:2 nInitC enInitializ

 .:3 SelectC  ใหลอจิก High เพื่อบอกใหเครื่องพิมพเปดรับขอมูลทางอินพุต 
  ถาใหบิตนี้เปน High จะยอมใหตอบสนอง Interrupt request 
ผานทางขา nAck( S6 )  

EnableC :4 inlerrupt .requests

 เปนบิตที่ใชกําหนดทิศทางของ Data port โดยถาเซ็ตเปน ‘0’ จะทําให 
Data port เปน Output, ถากําหนดใหเปน ‘1’ จะทําให Data port เปน Input ซึ่งบิตนี้จะไมปรากฎที่ขาของ
พอรตขนาน และ จะไมสามารถใชไดกับโหมด SPP  

.:5 ontrolDirectionCC

  .:6 UnusedC

  .:7 UnusedC
 

           
 
 

 
 

 ETT CO.,LTD.                                       13                                     WWW.ETT.CO.TH  



            คูมือการใชงานบอรด CP-JR LPT v1.0        

 
 

                  3 
ทฤษฎีไอซี 8255 

 
 
  
 
 ไอซี 8255 มีขนาด 40 ขา ทําหนาที่เปน ไอซีขยายพอรตซึ่งสามารถติดตอกับอุปกรณภายนอกได 3 
พอรตขนาด 8 บิต คือ PA, PB, PC โดยแตละพอรตสามารถกําหนดเปน Input หรือ Output ไดจากการ
เขียนโปรแกรม ซึ่งตําแหนงขาตางๆ แสดงดังภาพดานลาง โดยเนื้อหาในบทนี้ของไอซี 8255 อางอิงจาก
เว็บไซต (http://www.sharpmz.org) 
 

 
 

รูปแสดงตําแหนงขาของไอซี 8255 
 

 

 รูปทางดานบน, แสดงตําแหนง และ สัญญาลักษณตางๆ ของไอซี 8255 ซึ่งฟงกชั่น หรือ หนาที่การ
ทํางานของขาตางๆ สามารถอธิบายไดดังนี้ คือ  
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  คือ ขาขอมูลซึ่งสามารถทําหนาที่เปนไดทั้ง Input/Output โดยขอมูลที่เกิดจากการอาน 
หรือ เขียน จะตองปรากฏที่ขาเหลานี้ 

10 DD −

 CS ( Chip Select Input ) ถาขานี้มีสถานะ ‘0’ ไมโครโปรเซสเซอร สามารถ อาน หรือ เขียนขอมูล
ไปที่ไอซี 8255 ได 

  RD ( Read Input ) เมื่อใดก็ตามที่ขา CS กับขา RD มีสถานะ ‘0’ จะทําใหขาเอาทพุตของ 8255 
นั้นถูก Enable ซึ่งจะสงผลใหขอมูล ( จาก PA, PB หรือ PC )นั้นเขามาอยูบน System Data Bus         
( D0 – D7 ) 

 WR ( Write Input ) เมื่อใดก็ตามที่ขา CS กับขา WR มีสถานะ ‘0’ จะทําใหขอมูลจาก System 
Data Bus( D0 – D7 ) ถูกเขียนออกไปที่ไอซี 8255  

  ( Address Inputs ) ขาสัญญาณอินพุต 2 ขานี้ทําหนาที่เลือกพอรตของไอซี 8255 จาก 
System data bus ( D0 – D7 ) 

10 AA −

  และ 70,70 PBPBPAPA −− 70 PCPC −  ขาสัญญาณเหลานี้ใชเปนพอรต I/O ขนาด 8 บิต 
สามารถตอไปที่อุปกรณรอบนอกตางๆ ไดโดยตรง 
 

 โหมดการทํางานของไอซี 8255 จะมีทั้งหมด 3 โหมด คือ Mode 0, Mode 1, Mode 2 ซึ่งเนื้อหาใน
บทนี้ผูเขียนจะขอกลาวถึงเฉพาะโหมด 0 (Basic Input/Output) เทานั้น 
 

 
 

รูปแสดง Block diagram ของไอซี 8255 
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 จากรูปทางดานบนซึ่งแสดง Block diagram ของไอซี 8255 ซึ่งภายในจะแบงกลุมการทํางานออก
เปน 2 กลุม คือ Group A control และ Group B control  ซึ่งอธิบายไดดังนี้ คือ  
 

 Group A control : จะควบคุมพอรต A ทั้งพอรต และ 4 บิตบนของพอรต C 
 Group B control : จะควบคุมพอรต B ทังพอรต และ 4 บิตลางของพอรต C 

 

 ในสวนของการเลือกพอรตนั้นผูอานสามารถกําหนดไดจากขา A0 และ A1 ของไอซี 8255 ซึ่ง
อธิบายไดจากตารางดานลาง คือ  
 

ตารางแสดงการเขาถึงพอรตของไอซี 8255 
A0 A1 Port 
0 0 A 
0 1 B 
1 0 C 
1 1 Control 

 
 ในการติดตอกับไอซี 8255 คร้ังแรกผูอานจะตองสง Control word ไปใหกับ 8255 กอนเพื่อที่จะ
กําหนดโหมดการทํางาน รวมถึงฟงกชั่นการทํางานตางๆ ของไอซี 8255 เสียกอน ซึ่งการกําหนดนี้จะกําหนด
เพียงครั้งเดียวเทานั้นดังแสดงในรูปดานลาง คือ 
 

 
 

รูปแสดงโครงสรางคําส่ังของ Control Word 
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 จากรูปทางดานบนสามารถเขียนสรุปในรูปของตารางเพื่องายตอการนําไปใชงานไดดังแสดงในรูป
ดานลาง ซึ่งตารางทางดานลางนี้ คือ คา Control Word ในโหมด 0 
 

ตารางแสดงคา Control Word ในโหมด 0 ของไอซี 8255 
Contrl Word Port A Port B Port C (H) Port C (L) 

80 Out Out Out Out 
81 Out Out Out In 
82 Out In Out Out 
83 Out In Out In 
88 Out Out In Out 
89 Out Out In In 
8A Out In In Out 
8B Out In In In 
90 In Out Out Out 
91 In Out Out In 
92 In In Out Out 
93 In In Out In 
98 In Out In Out 
99 In Out In In 
9A In In In Out 
9B In In In In 
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                      4 
Inpout32.DLL ไลบรารี 
สําหรับติดตอพอรตขนาน 

 
 
  
 การเขียนโปรแกรมติดตอกับพอรตขนาน, สําหรับ Microsoft Visual Basic 6.0 นั้นไมไดรองรับการ
ทํางานในสวนนี้เอาไว แตอยางไรก็ตามไดมีบริษัทหลายแหงไดทําฟงกชั่น API (Application Programming 
Interface ) สําหรับติดตอกับพอรตขนานไวซึ่งผูอานสามารถเขาไปดาวนโหลดมาใชงานไดฟรีในรูปของแฟม
ขอมูลนามสกุล “ . DLL “ ซึ่งในที่นี้ผูเขียนจะนําเสนอไฟลชื่อ “ Inpout32.dll “  
 

 ไฟล Inpout32.dll นี้สามารถใชงานกับ Windows9x/NT/2000/XP ผูอานสามารถดาวนโหลดได
จากเวปไซด http://www.logix4u.net/inpout32.htm จากนั้นใหคลิ๊กเพื่อดานวโหลดไฟลบนชื่อ Download 

Inpout32.dll and source code here ซึ่งอยูทางดานลางของ Page ดังแสดงในรูปดานลาง 
 

 
 

รูปแสดงหนาโฮมเพจของไฟล Inpout32.dll 
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 จากรูปทางดานบนเมื่อผูอานทําการ Save ไฟลแลว ซึ่งไฟลที่ไดจะเปน Zip file จากนั้นใหคลิ๊กขวา
บนไฟล Zip แลวเลือกไปที่ Winzip => Extract to here ผูอานจะไดโฟลเดอรใหมชื่อ inpout32_source_ 
and_bins โดยภายในโฟลเดอรนี้จะมีไฟลที่จําเปนตางๆ รวมทั้งขอมูลการใชงาน, Source code และ ตัว
อยางโปรแกรม แตอยางไรก็ตามผูอานสามารถหาไฟล Inpout32.dll ไดจากแผน CD-ROM ที่แถมไปกับ
ผลิตภัณฑ  
 

 
 

รูปแสดงการ Extract ไฟล 
 

การติดต้ังไฟล Inpout32.dll 
 

 การเขียนโปรแกรม VB เพื่อติดตอกับพอรตขนานนั้นผูอานจะตองทําการติดตั้งไฟล Inpout32.dll 
ลงในเครื่อง PC ในตําแหนงที่ถูกตองเสียกอน ซึ่งไฟล Inpout32.dll นั้นภายในไดบรรจุ API Function ที่จํา
เปนสําหรับการติดตอกับพอรตขนานไว ซึ่งทําไดดังนี้ คือ 

 

  คัดลอก ( Copy ) ไฟล Inpout32.dll ไปไวที่ตําแหนง C:\WINDOWS\system (สําหรับ Win9x)  
  คัดลอก ( Copy ) ไฟล Inpout32.dll ไปไวที่ตําแหนง C:\WINDOWS\system32 (สําหรับ WinXP) 

 

ซึ่งไฟล Inpout32.dll นี้จะอยูในรูท “ ..\inpout32_source_and_bins\binaries\Dll ” ( สําหรับผู
อานที่ดาวนโหลดไฟลมาจาก Internet , แตถาใชไฟล Inpout32.dll จากแผน CD-ROM จะอยูในโฟลเดอร 
Dll file )  และ ไฟลนี้สามารถใชงานไดกับ Windows9x/Me/NT/2000/XP  ในสวนของการเรียกใชงานฟงก
ชั่น API จากไฟล Inpout32.dll จะขอยกไปอธิบายในสวนของการอธิบายตัวอยางโปรแกรม 
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ฟงกช่ันสําหรับการใชงาน 
 

 API function ที่ผูอานจะตองใชในการติดตอกับพอรตเครื่องพิมพ ( Parallel Port ) โดยหลักๆ จะมี
อยู 2 ฟงกชั่นเทานั้น คือ  
 
 
 

INP ( Reg ) ‘ เมื่อ Reg คือ ตําแหนงรีจิสเตอร เชน  378H คือ Data register ของพอรต LTP1 

 
 OUT Reg, Data ‘ เมื่อ Reg คือ ตําแหนงรีจิสเตอร และ Data คือ ขอมูลที่ผูอานตองการสงออกจาก PC 

 
 

        
 

 ETT CO.,LTD.                                       20                                     WWW.ETT.CO.TH  



            คูมือการใชงานบอรด CP-JR LPT v1.0        

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก ก. 
การเซ็ตอัพ BIOS สําหรับเลือกพอรต LPT 
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 BIOS คือ กลุมของคําสั่งคอมพิวเตอรที่ถูกโหลดอยูในชิปหนวยความจํา ( Memory chip ) บน
เมนบอรดของเครื่องคอมพิวเตอร ซึ่งคําสั่งตาง ๆ ใน BIOS จะเปนตัวประสานการสื่อสารระหวางระบบ 
Operating System ( เชน Win9X หรือ WinXP ) กับ Computer Hardware โดย BIOS จะไมข้ึนกับระบบ
ปฏิบัติการวินโดวนเวอรชั่นใด ๆ นอกจากนั้นผูอานสามารถ Update เวอรชั่นของ BIOS ในเวอรชั่นที่ใหม
กวาไดจากผูผลิตคอมพิวเตอร หรือ เมนบอรด 
 

การตรวจสอบโหมดของพอรตขนาน 
 

 ทางเดียวในการตรวจสอบการเซ็ตอัพคา BIOS ของพอรตเครื่องพิมพ ( Parallel Port ) คือ การ
ตรวจสอบคุณสมบัติใน Device Manager แตการตรวจสอบคุณสมบัติที่ Device Manager นั้นอาจใชไมได    
100% ( เนื่องจากใน Windows NT 4.0 จะไมมีสวนของ Device Manager ) ในการพิมพเอกสารโดยปกติ
ระบบจะเซ็ตอัพตัวเองเปนโหมด ECP/EPP อัตโนมัติ ซึ่งในการตรวจสอบระบบโดยดูจาก Device Manager 
ทําไดดังนี้ คือ 
 

1. เปดหนาตาง Device Manager 
 

 สําหรับ Windows 95, 98, และ ME 
 - คลิ๊กขวาที่ My Computer จาก Desktop จากนั้นคลิ๊กที่ Properties 
 - คลิ๊กที่แทบ Device Manager 
 

 
 

รูปแสดงการเปดหนาตาง Device Manager สําหรับ Win9x 
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 สําหรับ Windows 2000 และ XP 
 - คลิ๊กขวาที่ My Computer จาก Desktop จากนั้นคลิ๊กที่ Properties ( สําหรับ WinXP ใหคลิ๊กที่
เมนู Start จากนั้น คลิ๊กขวาที่ My Computer และ ตามดวยคลิ๊กที่ Properties )  
 - คลิ๊กที่แทบ Hardware 
 - คลิ๊กที่ปุม Device Manager ในแทบ Hardware 
 

 
 

รูปแสดงการเปดหนาตาง Device Manager สําหรับ Win2000/XP 
 

2. ดับเบิลคลิ๊กที่ Ports ในรายการที่แสดง, ซึ่งบางกรณีผูอานอาจจะไมเห็นคําวา ECP ( หรือ หมายความวา
BIOS ของผูอานอาจจะถูกเซ็ตอัพอยูในโหมดอื่นที่ไมใช ECP )  ดังแสดงดังรูปทางดานบน 
3. ดับเบิลคลิ๊กที่ Parallel Port (LPT1) เพื่อเขาสูหนาตาง Parallel Port Properties  
4. คลิ๊กที่แทบ Resources, ถาพอรตเครื่องพิมพ ( Parallel Port ) อยูในโหมด ECP ผูอานจะเห็นรายการ
ของ I/O ranges มี 2 อัน ดังแสดงในรูปดานลาง แตถาอยูในโหมด SPP หรือ EPP รายการของ I/O ranges 
จะมีเพียงอันเดียว  
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  ( ก ) แสดงโหมด EPP    ( ข ) แสดงโหมด ECP 
 
5. ไมวาจะอยูในโหมด EPP หรือ ECP , input/output range อันหนึ่งจะตองเริ่มตนที่ 0378 (สําหรับ LPT1)  
 

Note : การทํางานของโหมดเครื่องพิมพอาจจะไมถูกตอง, อีกทางหนึ่งในการตรวจสอบโหมดของพอรตเครื่องพิมพ 
คือ การตรวจสอบคาจาก BIOS ของเครื่องคอมพิวเตอร 

 
 
 
 
การแสดงคา และ การแกไขคาพอรตเครื่องพิมพใน BIOS 
 

 วิธีการเขาสู BIOS ของเครื่องคอมพิวเตอรตางๆ นั้นจะขึ้นอยูกับผูผลิตคอมพิวเตอร หรือ ผูผลิต
เมนบอรดของคอมพิวเตอร สําหรับคอมพิวเตอร Laptop บางเครื่องนั้นจะมี Configuration utility สําหรับ
เปลี่ยนแปลงคาตางๆ ใน BIOS แตโดยปกติผูอานจะสามารถเขาสู BIOS ไดในขณะคอมพิวเตอรกําลัง 
Start up ซึ่งเมื่อผูอานทําการ Restart เครื่องคอมพิวเตอร และ เห็นขอความ หรือ Logo ผูผลิตขึ้นมาจากนั้น
ใหผูอานกดคียที่ใชในการเขา BIOS  
 

 รายการคําสั่งของการเขาโหมด BIOS ของผูผลิตคอมพิวเตอร PC ตางๆ แสดงทางดานลาง ซึ่งถาผู
อานไมสามารถเขาโหมด BIOS ได ผูอานควรติดตอผูผลิตเครื่องคอมพิวเตอรเพื่อขอความชวยเหลือ หรือ 
รับขอมูลเกี่ยวกับการอัพเดท BIOS  
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คียตางๆ ที่คุณใชกดเพื่อเขาสู BIOS 
 

Compaq Presario 
กดคีย F10 เมื่อโลโก Compaq สีแสงแสดงขึ้น 
 

Dell Dimension 
กดคีย DELETE ขณะที่ System powers up  
 

Dell OptiPlex 
กดคีย F2 หรือ Ctrl + Alt + Enter ในระหวาง Startup 
 

Dell Latitude (except LM) 
กดคีย FN + F1 พรอมกัน 
 

Dell Inspiron and Latitude LM 
กดคีย F2 ในระหวาง Startup 
 

E-Machines 
กดคีย Delete ขณะที่ระบบ Starts up 
 

Gateway 
กดคีย F1 ขณะที่คอมพิวเตอร Starts 
 

HP Pavilion (most models) 
กดคีย F1 ขณะที่คอมพิวเตอร Start ที่ blue HP screen 
 

HP Vectra and Kayak 
กดคีย F2 ขณะที่คอมพิวเตอร Start ที่ blue HP screen 
 

IBM ThinkPad 
กดคีย FN + F1 พรอมกัน 
 

IBM Aptiva 
กดคีย F1 ขณะที่คอมพิวเตอร Start ที่ blue IBM screen 
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BIOS ของ AMI, Award, และ Phoenix  

 

 มี 3 บริษัทใหญๆ ที่เปนผูผลิต BIOS บนคอมพิวเตอร คือ AMI, Award, และ Phoenix ซึ่ง ชื่อบริษัท
มักจะแสดงตรงสวนบนของจอภาพ BIOS ( BIOS screen ) ซึ่งเนื้อหาในหัวขอนี้จะแสดงขั้นตอนการหา
ตําแหนงที่ผูอานจะเซ็ตอัพ Parallel Port ใน BIOS ของ 3 ผูผลิต (AMI, Award, และ Phoenix)  
 

 Award BIOS : 
ข้ันที่ 1. จาก Main menu, ใหผูอานไปที่ Integrated Peripherals และ กด Enter ตามลําดับ 
 

 
 

รูปแสดงหนาตาง Main menu 
 

ข้ันที่ 2. กด Enter ที่หัวขอ Onboard Parallel Mode จากนั้นเลือกโหมดที่ตองการโดยใชคีย           และ กด 
Enter เพื่อตกลง  
 

    
 

รูปแสดงการเลือกโหมดพอรตเครื่องพิมพ 
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ข้ันที่ 3. กดปุม Esc เพื่อออกไปที่หนาตาง Main menu จากนั้นทําการ Save คาที่ไดเปลี่ยนแปลง โดยไปที่ 
Save & Exit Setup 
 

 Phoenix - Award : 
ข้ันที่ 1. จาก Main menu, ใหผูอานไปที่ Integrated Peripherals และ กด Enter ตามลําดับ 

 

 
 
ข้ันที่ 2. กด Enter ที่หัวขอ Onboard Super IO Device ซึ่งจะไดดังรูปดานลาง 
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ข้ันที่ 3. ที่หัวขอ Parallel Port Mode เปนจุดที่ใชกําหนดโหมดการทํางานของเครื่องพิมพ ( Parallel Port ) 
ซึ่งการกําหนดโหมดวิธีแรก คือ การใชคีย Page Up กับ Page Down ในการเปลี่ยนโหมด หรือ อีกวิธีหนึ่ง 
คือ กดปุม Enter ที่หัวขอ Onboard Super IO Device ซึ่งจะมีหนาตางการเลือกโหมดขึ้นมาดังแสดงในรูป
ดานลาง  
 

 
 

ข้ันที่ 4. เมื่อเลือกโหมดตามตองการแลว ใหกดปุม ESC เพื่อออกไปที่ Main menu เพื่อทําการ Save การ
เปลี่ยนแปลงนี้ ที่ Save & Exit Setup  
 

 AMI BIOS : 
ข้ันที่ 1. จาก Main menu, ใหผูอานไปที่ Peripheral Setup และ กด Enter ตามลําดับ 
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ข้ันที่ 2. กด Enter ที่หัวขอ Parallel Port Mode จะไดดังภาพดานลาง จากนั้นเลือกโหมดตามตองการ 
 

   
 
ข้ันที่ 3. เมื่อเลือกโหมดตามตองการแลว ใหกดปุม ESC เพื่อออกไปที่ Main menu เพื่อทําการ Save การ
เปลี่ยนแปลงนี้ ที่ Save Settings and Exit  
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ภาคผนวก ข. 
การเซ็ตอัพคาตางๆ กอนการใชงาน VB 6.0 
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การแกไขปญหาเกี่ยวกับฟอนตภาษาไทย 
 

ข้ันที่ 1. คลิ๊กที่ปุม Start => Run แลวพิมพคําวา WIN.INI  
 

 
 

ข้ันที่ 2. ผูอานจะเห็นไฟล Notepad ชื่อ “ Win.ini “ ข้ึนมา จากนั้นใหเพิ่มบรรทัด Tahoma,222=Tahoma,0 
หลังขอความ [FontSubstitutes] ดังรูปดานลาง 
 

 
 

ข้ันที่ 3. ใหผูอาน Save ไฟลที่แกไขนี้โดยไปที่ File => Save จากนั้นให  Restart คอมพิวเตอร 
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เปล่ียนฟอนตที่ Code Editor ใหพิมพภาษาไทยได 
 

 การใชงาน Visual Basic 6.0 ผูอานจะเห็นวาไมสามารถพิมพภาษาไทยในสวนของ Code Editor 
ได ดังนั้น ข้ันตอนตอไปนี้จะแสดงการแกไขฟอนตใหสามารถพิมพภาษาไทย ได  
 

ข้ันที่ 1. เปดโปรแกรม Visual Basic 6.0 ตามขั้นตอนที่ผูอานเคยทํามา จากนั้นไปที่เมนู Tools => Option 
 

 
 

ข้ันที่ 2. ที่แท็บ Editor Format ใหเลือก Font เปน FreesiaUPC และ เลือก Size เปน 14 จากนั้นกดปุม OK 
ดังภาพดานลาง  
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การกําหนดคําส่ัง Option Explicit 
 

 การประกาศตัวแปรในการเขียนโปรแกรมจะเปนการบอกใหเครื่องคอมพิวเตอรเตรียบพื้นที่ในหนวย
ความจําสําหรับเก็บขอมูลชนิดนั้นๆ ไว ซึ่งใน Visual Basic จะใชคําวา Dim ( Dimension ) ในการประกาศ
ตัวแปร 
 

 สําหรับการอางชื่อตัวแปรใหมใน VB ตัวแปรนั้นจะถูกสรางโดยอัตโนมัติ โดยผูอานไมตองใชคําสั่ง 
Dim เลย ซึ่งการกระทําดังกลาวมีขอเสียตรงที่วา ถาผูอานเขียนชื่อตัวแปรผิด โปรแกรมจะมองวาเปนการ
ประกาศชื่อตัวแปรใหมโดยทันที ดังตัวอยางที่แสดงดานลาง 
 

Example โปรแกรมคํานวณเลขยกกําลังสอง  
 

 
 

1 
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Command Button ชื่อ Command
 

 

V           
1. จากโปรแกรมทางดานขาง, เมื่อผูอาน Run
โปรแกรมผูอานจะเห็นวาโปรแกรมทํางานไดทัน
ทีโดยที่ไมเกิด Error ใดๆ ขึ้นเลย ถึงแมวาจะไม
ไดประกาศตัวแปรใดๆ ดวยคําส่ัง Dim ก็ตาม 
2. ทดลองใสคาจํานวนเต็ม “5” ใน InputBox ที่
ปรากฎขึ้นหลังจากกดปุม Input^2 ซึ่งผูอานจะ
ไดคําตอบเทากับ 25 ซึ่งถูกตอง 
 ใสคาจํานวนเต็ม = 5 
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จากนั้นใหผูอานทดลองเปลี่ยนชื่อตัวแปรจาก InputValue เปน InputVaiue  ดังแสดงในภาพดานลาง 
 

ถาบังเอิญพิมพชื่อตัวแปรผิด ซึ่งผลจะทําใหคํา
ตอบที่ควรจะเปนนั้นผิดตามไปดวยโดย Visual
basic จะไมมีการฟองความผิดพลาดใดๆ ทั้งส้ิน
แตจะกลับมองวาเปนการประกาศตัวแปรใหม
แทน ซึ่งถาโปรแกรมของผูอานมีขนาดใหญมากๆ,
ผูอานอาจจะหาความผิดพลาดนี้ไมเจอได 

 

สมมุติพิมพชื่อผิด 

 

การแกไขปญหานี้สามารถทําไดโดยใชคําสั่ง Option Explicit เพื่อเปนการบอก Visual Basic วาใหมีการ
ประกาศชื่อตัวแปรกอนการใชงานทุกครั้ง และ เราสามารถบอกให Visual Basic ใสคําสั่งนี้ใหเราทุกครั้ง
โดยใหผูอานไปที่เมนู Tools => Option, ในแทบ Editor ใหผูอานติ๊กเครื่องหมายถูกที่ Require Variable 
Declaration จากนั้นใหกดปุม OK 
 

 
 

ทําการปดโปรแกรม Visual Basic แลว เปดโปรแกรมขึ้นมาใหม ทดลองดับเบิลคลิ๊กที่ Form ผูอานควรจะ
เห็นขอความ Option Explicit ข้ึนมา 
 

 

 ใสเครื่องหมายถูก 

ขอความที่ควรปรากฏ 
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ทีนี้ถาผูอานเผลอเขียนชื่อตัวแปลผิด หรือ ใชตัวแปลโดยไมไดประกาศไวกอนผูอานจะไดรับขอความ ดัง
แสดงในรูปดานลางจาก Visual Basic พรอมทั้งบอกตําแหนงที่ผิดดวย 
 

 
 

 ETT CO.,LTD.                                       VI                                     WWW.ETT.CO.TH  



            คูมือการใชงานบอรด CP-JR LPT v1.0        

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก ค. 
วงจร Schematic บอรด CP-JR LPT/ET-BASE LPT V1.0 
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